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Πρόλογος 

 
Όπως ήδη γνωρίζουμε σχεδόν σε όλους τους τομείς έχουν διεισδύσει οι 
ηλεκτρονικοί υπολογιστές. Εξειδικευμένοι υπολογιστές βρίσκουν εφαρμογή σε 
τομείς όπως της ιατρικής (π.χ. αξονικός τομογράφος) της αεροναυπηγικής ,της 
μετεωρολογίας κ.α. Μια πολύ διαδεδομένη μορφή τέτοιου υπολογιστή, είναι και οι 
Προγραμματιζόμενοι Λογικοί Ελεγκτές ή PLC (Programmable Logic Controllers). Στην 
ουσία είναι μία ψηφιακή ηλεκτρονική συσκευή, η οποία  χρησιμοποιεί μια 
προγραμματιζόμενη μνήμη. Κάθε φορά με τον κατάλληλο προγραμματισμό μπορεί 
να συμπεριφέρεται διαφορετικά και να εκτελεί μια ποικιλία λειτουργιών σύμφωνα 
με τις απαιτήσεις του προβλήματος που έχουμε να αντιμετωπίσουμε. 

 

 

Περίληψη 
 
 Στην παρούσα πτυχιακή θα ασχοληθούμε με τον προγραμματισμό ενός PLC 
(Programmable Logic Controller) για την επίτευξη ενός αυτοματισμού. Ο 
προγραμματισμός του PLC θα γίνει με την γλώσσα προγραμματισμού ladder μέσω 
του προγράμματος Cx- Programmer. Ο αυτοματισμός αυτός θα μας βοηθήσει να 
έχουμε τον πλήρη έλεγχο ενός ηλεκτρικού τρυπανιού με δυο λειτουργίες αυτόματη 
και χειροκίνητη (auto-manual). Επίσης για τον έλεγχο και την οπτικοποίηση θα 
χρησιμοποιήσουμε ένα πρόγραμμα SCADA (Supervisory Control and Data 
Acquisition) το Cx-Supervisor. Τέλος θα κάνουμε μια μελέτη για τον προσδιορισμό 
διατομών καλωδίων, των θερμικών , των ασφαλειών και των κινητήρων που θα 
χρειαστούμε για την επίτευξη του αυτοματισμού.  
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Κεφάλαιο 1ο - Εξέλιξη και Δυνατότητες των 
PLC  
1.1 Ιστορική Εξέλιξη του PLC 

Η χρήση αυτοματισμών χρονολογείται από την αρχαιότητα και σε μεγάλο βαθμό 
είναι Ελληνική ιστορία. Πρώτοι οι αρχαίοι Έλληνες χρησιμοποίησαν αυτόματα 
συστήματα όπως μηχανισμοί ελέγχου της στάθμης νερού δεξαμενής. Η εξέλιξη των 
αυτοματισμών ακολούθησε φυσικά την εξέλιξη της τεχνολογίας. Τους υδραυλικούς 
αυτοματισμούς ακολούθησαν καθαρά μηχανικοί αυτοματισμοί με τη χρήση μοχλών 
και γραναζιών. Με τη χρήση του ηλεκτρισμού οι αυτοματισμοί έκαναν το μεγάλο 
άλμα κυρίως με τη χρησιμοποίηση των ηλεκτρονόμων. Μετά το τέλος του δευτέρου 
παγκοσμίου πολέμου χρησιμοποιήθηκε η ηλεκτρονική λυχνία, αλλά η ανακάλυψη 
του τρανζίστορ (1950) και των ημιαγωγών έκανε τους αυτοματισμούς μικρότερους 
σε όγκο, πιο εύκολους στην κατασκευή και σαφώς πιο οικονομικούς. Από τη 
δεκαετία του 60 οι μηχανικοί προσπάθησαν να αξιοποιήσουν την τεχνολογία των 
υπολογιστών. Από τις πρώτες εφαρμογές των υπολογιστών στην βιομηχανία ήταν 
οι αυτόματες εργαλειομηχανές οι οποίες μέχρι τότε χρησιμοποιούσαν περισσότερο 
μηχανολογικούς αυτοματισμούς. Το 1975 ήρθε η επανάσταση στην πληροφορική 
με την κατασκευή του πρώτου μικροϋπολογιστή ο οποίος είχε ευρεία εφαρμογή .Τη 
δεκαετία του 80 οι πρώτοι προγραμματιζόμενοι λογικοί ελεγκτές PLC μπαίνουν σε 
μαζική παραγωγή και αντικαθιστούν σταδιακά κυρίως στη βιομηχανία τους 
ηλεκτρονόμους.  

 
 

 
 

  

Εικόνα 1. Ο πρώτος προγραμματιζόμενος  
λογικός ελεγκτής (PLC) τον οποίο  
εφεύρε ο Ernst Dummermuth το 1974 
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1.2 Ορισμός του PLC 

Ο Προγραμματιζόμενος  Λογικός  Ελεγκτής (PLC) είναι ένα σύστημα αυτοματισμού 
που χρησιμοποιείται για την αυτοματοποίηση των τυπικών βιομηχανικών 
ηλεκτρομηχανολογικών διεργασιών. Λειτουργεί με βάση την τεχνολογία των 
Ηλεκτρονικών Υπολογιστών και είναι σε θέση : 

· να δέχεται διάφορα ηλεκτρικά σήματα (inputs) 
· να τα επεξεργάζεται  
· να παράγει τα κατάλληλα σήματα εξόδου (outputs) ,τα οποία θα 

ενεργοποιήσουν τις υπό έλεγχο διατάξεις. 
 

 

Εικόνα 2. Δυνατότητες του PLC 

 

 

Δομή του PLC 

Σε ένα PLC μπορούμε να το διακρίνουμε τα παρακάτω μέρη : 

1. Την κεντρική μονάδα επεξεργασίας ( Central Processing Unit, CPU) που 
αποτελεί την καρδία του PLC. 

2. Την μονάδα τροφοδοσίας. 
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3. Τις μονάδες εισόδων – εξόδων ( I/O modules )  
4. Τη μονάδα μνήμης της CPU. 
5. Την επικοινωνία του PLC. 

 

Παρακάτω εξηγούνται όλα τα δομικά μέρη ενός PLC : 

 

1) Η κεντρική μονάδα επεξεργασίας CPU είναι η μονάδα που γίνεται η 
επεξεργασία του προγράμματος και η εκτέλεση των εντολών του με βάση τις 
καταστάσεις των σημάτων εισόδου και εξόδου. Ανάλογα με τα σήματα εισόδου 
– εξόδου και τα δεδομένα που είναι αποθηκευμένα στη μνήμη, παράγει τα 
διάφορα σήματα εξόδου. Η επεξεργασία ουσιαστικά γίνεται από ένα 
μικροϋπολογιστή δηλαδή τον μικροεπεξεργαστή και τη μνήμη. 
 

2) Η μονάδα τροφοδοσίας ενός PLC έχει σκοπό να δημιουργήσει από την τάση του 
δικτύου  τροφοδοσία τις απαραίτητες εσωτερικές τάσεις, που απαιτούνται για 
την τροφοδοσία των ηλεκτρονικών στοιχείων ( τρανζίστορ, ολοκληρωμένα κτλ ). 
Οι εσωτερικές τάσεις είναι συνήθως DC 5V, DC 9V, DC 24V. Σε μερικά μοντέλα η 
μονάδα τροφοδοσίας είναι ξεχωριστό κομμάτι ενώ σε άλλα είναι 
ενσωματωμένο στην κύρια συσκευή. Σε όλες τις περιπτώσεις πρέπει να 
προσέχουμε να μην υπερφορτίζουμε την μονάδα τροφοδοσίας γιατί υπάρχει 
σοβαρό ενδεχόμενο να υποστεί βλάβη. 
 

3) Οι μονάδες εισόδου – εξόδου αποτελούν τον τρόπο επικοινωνίας της κεντρικής 
μονάδας με τον έξω κόσμο. Δηλαδή οι αισθητήρες, οι διακόπτες, τα μπουτόν 
κ.α. που δίνουν τις εντολές αποτελούν τις μονάδες εισόδου και οι 
ηλεκτρονόμοι, οι βαλβίδες, οι λυχνίες ένδειξης κ.α. που εκτελούν τις εντολές 
του αυτοματισμού αποτελούν τις μονάδες εξόδου . Τέλος οι μονάδες εισόδου –
εξόδου χωρίζονται σε ψηφιακές και αναλογικές. Ψηφιακές  που αναγνωρίζουν 
τιμές «0» και «1» δηλαδή χαμηλή και υψηλή τάση αντίστοιχα. Αναλογικές στις 
οποίες το σήμα εισόδου είναι αναλογικό. Τα σήματα αυτά είναι συνήθως από 0 
έως 10V ή -10V έως 10V. 
 

4) Η μνήμη της CPU διακρίνεται στη RAM, στη ROM και στην EEPROM. Στη RAM 
αποθηκεύεται το εκτελούμενο πρόγραμμα και έχουμε τη δυνατότητα να 
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γράφουμε και να σβήνουμε. Όμως η μνήμη RAM χάνει τα δεδομένα της όταν το 
PLC είναι εκτός τροφοδοσίας και για το λόγο αυτό συνδέεται με μπαταρία ώστε 
το περιεχόμενό της να μην χάνεται σε περίπτωση διακοπής ρεύματος. Η μνήμη 
ROM είναι το κομμάτι της μνήμης όπου ο κατασκευαστής έχει αποθηκεύσει το 
λειτουργικό σύστημα του PLC. Τέλος στην  EEPROM αποθηκεύεται το 
πρόγραμμα όταν πάρει την τελική του μορφή. 
 

5) Η επικοινωνία  χρησιμοποιείται για να λαμβάνει και να διαβιβάζει τα δεδομένα 
του PLC. Ασχολείται με δράσεις όπως επαλήθευση της συσκευής, την απόκτηση 
δεδομένων, το συγχρονισμό μεταξύ των εφαρμογών του χρήστη και  τη 
διαχείριση σύνδεσης. 

 

 

Εικόνα 3. Δομή ενός PLC 
                                                                

1.3 Πλεονεκτήματα των PLC 

Τα πλεονεκτήματα των PLC σε σχέση με τους κλασικούς αυτοματισμούς είναι το 
χαμηλό κόστος κατασκευής σε σχέση με τα αντίστοιχα υλικά των κλασικών 
αυτοματισμών (βοηθητικές επαφές, χρονικά  κ.α.) και ο χρόνος κατασκευής των 
κυκλωμάτων που είναι κατά πολύ μικρότερος.  Επίσης τα PLC παρουσιάζουν πολλά 
πλεονεκτήματα και στην βιομηχανία όπως : 

· Το μικρό κόστος συντήρησης. Αφού τα PLC χαλάνε σπάνια και ο χρόνος 
εντοπισμού και αποκατάστασης της βλάβης είναι πολύ μικρός. 

· Δέχονται τροποποιήσεις στους αυτοματισμούς τους, αφού η αλλαγή γίνεται 
γρήγορα αλλάζοντας μόνο το πρόγραμμα. 
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· Υπάρχει η δυνατότητα επεκτασιμότητας του αυτοματισμού, είτε αλλάζοντας 
το πρόγραμμα του αυτοματισμού είτε τοποθετώντας νέες μονάδες εισόδων 
και εξόδων.   

· Έχουν δυνατότητες δικτύωσης. Μπορούν να συνδεθούν με περιφερειακές 
μονάδες ή υπολογιστές, για έλεγχο, επιτηρήσει, συντονισμό, ανάλογα με τις 
απαιτήσεις του αυτοματισμού. 

· Καταλαμβάνουν πολύ μικρό χώρο. 
· Είναι αξιόπιστα και έχουν μεγάλη διάρκεια ζωής. 
· Μεγάλη ταχύτητα εκτέλεσης των προγραμμάτων. Αυτό συμβαίνει διότι δεν 

υπάρχουν μηχανικά μέρη, και η επεξεργασία των σημάτων εισόδου γίνεται 
από μικροϋπολογιστή. 
 

1.4 Γλώσσες Προγραμματισμού ενός PLC 

Υλοποιώντας έναν αυτοματισμό σε PLC το δύσκολο κομμάτι δεν είναι τόσο το 
hardware το υλικό μέρος (πχ. σύνδεση  μπουτόν, τερματικών διακοπτών κτλ ) όσο ο 
τρόπος που θα λειτουργήσει το υλικό. Ο τρόπος αυτός εξαρτάται αποκλειστικά από 
το software δηλαδή το λογισμικό, που έχει να κάνει με τον προγραμματισμό του 
PLC. Με τον σωστό προγραμματισμό εξασφαλίζουμε την αξιοπιστία της εφαρμογής 
που έχουμε επιλέξει, με τέτοιο τρόπο ώστε  να υπάρχει και η δυνατότητα αλλαγών. 

Η επιλογή της γλώσσας προγραμματισμού εξαρτάται από τις γνώσεις του χρήστη 
και το είδος της εφαρμογής που θέλει να εκτελέσει. Τρείς είναι οι γλώσσες πού 
έχουν επικρατήσει. Η πρώτη, που είναι και η πιο γνωστή, είναι η γλώσσα LADDER 
(LAD) ή αλλιώς σχέδιο επαφών, η δεύτερη είναι η STATEMENT LIST (STL) ή λίστα 
εντολών και τρίτη η FUNCTION BLOCK DIAGRAM (FDB) ή γλώσσα λογικού 
διαγράμματος. 

· Η LADDER (LAD) είναι η πρώτη γλώσσα που χρησιμοποιήθηκε για τον 
προγραμματισμό PLC. Μοιάζει πολύ με την μορφή ενός ηλεκτρολογικού 
σχεδίου αυτοματισμού. Αυτό έχει ως σκοπό την εύκολη εκμάθηση της από 
τους τελικούς χρήστες.  
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Εικόνα 4. 

 
 

· Η γλώσσα STATEMENT LIST (STL) έχει την μορφή κειμένου. Η σύνταξη της 
μοιάζει πολύ με αυτή του κώδικα μηχανής (γλώσσα χαμηλού επιπέδου). Η 
STL μπορεί να εκμεταλλευτεί  στο βέλτιστο όλες τις δυνατότητες ενός PLC και 
αυτό αποτελεί μεγάλο πλεονέκτημα σε σχέση με τις άλλες μορφές 
προγραμματισμού.  
 

 

Εικόνα 5. 

 

· Η FUNCTION BLOCK DIAGRAM (FDB) είναι μια γραφική γλώσσα. Ο κώδικας 
της αναπαρίστανται με λογικές πύλες μέσα σε κουτιά παρόμοια με την 
άλγεβρα Bool.  

 

Εικόνα 6. 

 



 
 

Κεφάλαιο 2ο - Δυνατότητες των 
Προγραμμάτων Cx-
2.1 Περιγραφή και δυνατότητες  του προγράμματος

Γενικά 

Το Cx-Programmer είναι ένα εργαλείο προγραμματισμού της εταιρίας  
το οποίο είναι υπεύθυνο για την δημιουργία, την δοκιμή και την διατήρηση ενός 
προγράμματος. Παρέχει δυνατότητες για την υποστηρίξ
μια μονάδα PLC. Τέλος το Cx
προσωπικό υπολογιστή και να υποστηριχθεί από το περιβάλλον της 
Windows.   

Το περιβάλλον του Cx-Programmer

Σε αυτή την παράγραφο θα περιγράψουμε τις βασικές δυνατότητες που έχουμε 
ανοίγοντας ένα παράθυρο του Cx

 

Εικόνα 

  

 

Δυνατότητες των 
-Programmer/Cx-Supervisor

δυνατότητες  του προγράμματος Cx-Programmer

είναι ένα εργαλείο προγραμματισμού της εταιρίας  PLC
το οποίο είναι υπεύθυνο για την δημιουργία, την δοκιμή και την διατήρηση ενός 
προγράμματος. Παρέχει δυνατότητες για την υποστηρίξει και την  επικοινωνία με 

Cx-Programmer μπορεί να εγκατασταθεί σε έναν 
προσωπικό υπολογιστή και να υποστηριχθεί από το περιβάλλον της 

Programmer 

Σε αυτή την παράγραφο θα περιγράψουμε τις βασικές δυνατότητες που έχουμε 
Cx-Programmer. 

Εικόνα 7. Περιβάλλον Cx-Programmer 

7 

Supervisor 
Programmer 

PLC OMRON 
το οποίο είναι υπεύθυνο για την δημιουργία, την δοκιμή και την διατήρηση ενός 

ει και την  επικοινωνία με 
μπορεί να εγκατασταθεί σε έναν 

προσωπικό υπολογιστή και να υποστηριχθεί από το περιβάλλον της Microsoft 

Σε αυτή την παράγραφο θα περιγράψουμε τις βασικές δυνατότητες που έχουμε 
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Επεξήγηση δυνατοτήτων του Cx-Programmer : 

· Το παράθυρο του Project Workspace μας δείχνει από τι αποτελείται το 
πρόγραμμα μας σε μορφή ιεραρχικού δέντρου. Με το πλήκτρο  του Project 
Workspace μπορούμε να ενεργοποιήσουμε και να απενεργοποιήσουμε το 
παράθυρο . 

· Με το Save project αποθηκεύουμε το πρόγραμμα στον φάκελο που έχουμε 
επιλέξει. 

· Στην περιοχή της ladder programming workspace (rung) γράφουμε το 
πρόγραμμα στην γλώσσα προγραμματισμού ladder. Ένα rung είναι μια ενιαία 
γραμμή του προγράμματος, το οποίο περιέχει ένα σύνολο λογικών εντολών 
που επιτρέπουν την ροή του προγράμματος από αριστερά προς τα δεξιά. To 
Cx-Programmer με την ολοκλήρωση των εντολών ενός rung δημιουργεί νέο 
rung αυτόματα. Επίσης κάθε rung μπορεί να περιέχει ένα σχόλιο, το οποίο 
εισάγεται στο κενό του rung properties(το οποίο εμφανίζεται με διπλό κλικ 
επάνω στο rung).  

· Ladder contacts είναι οι επαφές που χρησιμοποιούμε για την υλοποίηση του 
προγράμματος.Ladder coils είναι οι έξοδοι που ενεργοποιούνται μέσω των 
επαφών.Ladder instructions είναι εντολές που δίνουν επιπλέον δυνατότητες 
στο πρόγραμμα όπως είναι η προσθήκη χρονικών (timers), απαριθμητών 
(counters), λογικών πυλών κτλ. Ακόμη με την χρήση των function blocks 
μπορούμε να υλοποιήσουμε περίπλοκα προγράμματα, που θα 
κατασκευαστούν από μικρότερο και πιο εύχρηστο κώδικα. 

· Με το πλήκτρο work online simulator πετυχαίνουμε την προσομοίωση του 
προγράμματος που έχουμε υλοποιήσει στο περιβάλλον του Cx-Programmer. 
Επιλέγοντας το work online καταφέρνουμε την επικοινωνία του Cx-
Programmer με το PLC. Οπότε τώρα μπορεί να γίνει η μεταφορά ενός 
προγράμματος στο PLC. 

· Η επιλογή transfer to PLC μεταφέρει δεδομένα από το Cx-Programmer στο 
PLC. Αυτή η επιλογή είναι διαθέσιμη μόνο όταν το Cx-Programmer είναι σε 
απευθείας σύνδεση με το PLC δηλαδή έχει επιλεχτεί το work online. Επιπλέον 
όταν πραγματοποιούμε κάποια αλλαγή στο πρόγραμμα πρέπει να το 
περάσουμε εκ νέου στο PLC. 

· Με την επιλογή του transfer from PLC γίνεται η αντίστροφη διαδικασία από 
ότι επιλέγοντας το transfer to PLC. Δηλαδή τώρα μεταφέρονται δεδομένα 
από το PLC στο Cx-Programmer. 
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2.2 Πώς να φτιάξουμε ένα πρόγραμμα 

Για να φτιάξουμε ένα πρόγραμμα πρέπει αρχικά να φτιάξουμε ένα  αρχείο στο 
οποίο θα αποθηκευθεί το πρόγραμμα. 
Υλοποίηση αρχείου στο Cx-Programmer: 
Αρχικά πατάμε  File → New συμπληρώνουμε τα κενά και μετά OK 

 

Εικόνα 8. 

 

Στο κενό του Device Name συμπληρώνουμε το όνομα του αρχείου. Στο κενό του 
Device Type επιλέγουμε τον τύπο του PLC που θα χρησιμοποιήσουμε, ακόμη 
μπορούμε πατώντας επάνω στο settings να καθορήσουμε και τον τύπο της CPU που 
έχει το PLC. Τέλος στο κενό του Network Type καθορίζουμε τον τρόπο επικοινωνίας 
του υπολογιστή που θα φτιάξουμε το πρόγραμμα με το PLC. Η επικοινωνία  μπορεί 
να γίνει μέσω Ethernet, USB κ.α. 

Στην συνέχεια πραγματοποιούμε τον αυτοματισμό στο περιβάλλον του Cx-
Programmer ανάλογα με την εφαρμογή που θέλουμε να υλοποιήσουμε. 
 

Στάδια σχεδιασμού ενός αυτοματισμού στο Cx-Programmer: 

· Πλήρες διατύπωση της εφαρμογής χωρίς ασάφειες και κενά. 
· Καθορισμός των στοιχείων εισόδου και εξόδου. 
· Κατασκευή προγράμματος στο Cx-Programmer. 

 



 
 

Παράδειγμα 

Έστω ότι έχουμε ένα μοτέρ που για την ενεργοποίηση του χρειάζεται το πάτημα 
ενός μπουτόν και για την απενεργοποίηση κάποιο άλλο. Επίσης χρειαζόμαστε και 
δύο ενδεικτικές λυχνίες, μια για την ενεργοποίηση και μία για την απενεργοποίηση.

Είσοδοι 

I0.0: NO επαφή του μπουτόν start
I0.1: NC επαφή του μπουτόν stop

Έξοδοι 

Q100.0: Λειτουργία του μοτέρ  
Q100.1: Λυχνία ένδειξης λειτουργίας μοτέρ
Q100.2: Λυχνία ένδειξης μη λειτουργίας μοτέρ

 

  

 

έχουμε ένα μοτέρ που για την ενεργοποίηση του χρειάζεται το πάτημα 
ενός μπουτόν και για την απενεργοποίηση κάποιο άλλο. Επίσης χρειαζόμαστε και 
δύο ενδεικτικές λυχνίες, μια για την ενεργοποίηση και μία για την απενεργοποίηση.

start  
stop 

100.1: Λυχνία ένδειξης λειτουργίας μοτέρ 
100.2: Λυχνία ένδειξης μη λειτουργίας μοτέρ 

Εικόνα 9. 

10 

έχουμε ένα μοτέρ που για την ενεργοποίηση του χρειάζεται το πάτημα 
ενός μπουτόν και για την απενεργοποίηση κάποιο άλλο. Επίσης χρειαζόμαστε και 
δύο ενδεικτικές λυχνίες, μια για την ενεργοποίηση και μία για την απενεργοποίηση. 
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2.3 Περιγραφή και δυνατότητες  του προγράμματος Cx-Supervisor 

Γενικά 

Το Cx-Supervisor είναι ένα πρόγραμμα της εταιρίας PLC OMRON το οποίο μας δίνει 
την δυνατότητα σχεδιασμού και οπτικοποίησης οποιαδήποτε υλοποιήσιμης 
εφαρμογής. Μπορεί να συνδεθεί άμεσα με το Cx-Programmer και να έχει τον 
πλήρη έλεγχο του.   Το Cx-Supervisor δεν είναι ένα απλό πρόγραμμα σχεδιασμού 
αλλά ένα λογισμικό εργαλείο SCADA(Supervisory Control and Data Acquisition), το 
οποίο έχει ως σκοπό την εποπτεία και επεξεργασία πληροφοριών από απόσταση.     

2.4 Εποπτικός Έλεγχος και Συλλογή Δεδομένων (SCADA) 

Ένα σύστημα SCADA όπως προαναφέραμε έχει ως σκοπό την εποπτεία και τον 
έλεγχο διεργασιών οι οποίες βρίσκονται σε απομακρυσμένα σημεία. Η διαδικασία 
λειτουργίας ενός τέτοιου συστήματος είναι η συλλογή πληροφοριών, η αποστολή 
τους σε ένα κεντρικό σημείο επεξεργασίας, η εκτέλεση της απαραίτητης ανάλυσης 
και ελέγχου και τέλος η παρουσίαση της πληροφορίας  σε διάφορες οθόνες 
χειρισμού και εποπτείας. Ένα σύστημα SCADA χρησιμοποιεί έναν κεντρικό 
υπολογιστή μεγάλης υπολογιστικής ισχύος στον οποίο βρίσκεται το λογισμικό του 
SCADA. Η απαιτούμενη τηλεμετρία επιτυγχάνεται με την εγκατάσταση RTUs. Τα 
RTUs λαμβάνουν κάποιες μετρήσεις (τάση, πίεση, θερμοκρασία κτλ), τις 
μετατρέπουν σε ηλεκτρικά σήματα και τα σήματα αυτά τα μεταδίδουν ασύρματα ή 
ενσύρματα στον κεντρικό υπολογιστή. Στην συνέχεια γίνεται η επεξεργασία των 
σημάτων από τον κεντρικό υπολογιστή και έτσι λαμβάνονται κάποια 
συμπεράσματα. 

 

2.5 Το περιβάλλον του Cx-Supervisor 

Σε αυτή την παράγραφο θα περιγράψουμε τις  δυνατότητες του προγράμματος  Cx-
Supervisor . 



 
 

 

Επεξήγηση δυνατοτήτων του Cx-
 

· Επιλέγοντας Save Page αποθηκεύουμε τις αλλαγές της σελίδας στην οποία 
δουλεύουμε.  

· Με τα Graphic Objects δίνεται η δυνατότητα σχεδιασμού και επεξεργασίας 
γραφικών αντικειμένων. 

· Με την επιλογή του Help 
του προγράμματος. 

· Το παράθυρο Workspace 
δενδροειδή μορφή. Με το 
ενεργοποιήσουμε και να απενεργοποιήσουμε το συγκεκριμένο παράθυρο. 

· Με το Device Setup καθορίζεται η επικοινωνία του 
Programmer αλλά και με το 

 

Εικόνα 10. 

-Supervisor : 

αποθηκεύουμε τις αλλαγές της σελίδας στην οποία 

δίνεται η δυνατότητα σχεδιασμού και επεξεργασίας 

 Index δίνεται η επεξήγηση των βασικών στοιχείων 

 μας δείχνει όλη την πορεία του προγράμματος σε 
δενδροειδή μορφή. Με το πλήκτρο του Workspace μπορούμε να 
ενεργοποιήσουμε και να απενεργοποιήσουμε το συγκεκριμένο παράθυρο. 

καθορίζεται η επικοινωνία του Cx-Supervisor
αλλά και με το PLC που έχουμε επιλέξει. 

12 

 

αποθηκεύουμε τις αλλαγές της σελίδας στην οποία 

δίνεται η δυνατότητα σχεδιασμού και επεξεργασίας 

δίνεται η επεξήγηση των βασικών στοιχείων 

μας δείχνει όλη την πορεία του προγράμματος σε 
μπορούμε να 

ενεργοποιήσουμε και να απενεργοποιήσουμε το συγκεκριμένο παράθυρο.  
Supervisor  με το Cx-
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· Χάρις το Point Editor μπορούμε να δηλώσουμε στο Cx-Supervisor τις 
μεταβλητές εισόδου (inputs) και τις μεταβλητές εξόδου (outputs) , που 
αποτελούν μέρος του προγράμματος που έχουμε υλοποιήσει στο Cx-
Programmer. 

· Ανοίγοντας το Graphics Library Editor ο χειριστής έχει την δυνατότητα 
επιλογής πληθώρα γραφικών αντικειμένων για όποια εφαρμογή θέλει να 
οπτικοποιήσει. 

· Με το πλήκτρο Stop the Runtime σταματάει η εξομοίωση της εφαρμογής που 
έχει σχεδιαστεί στο περιβάλλον του Cx-Supervisor.Επίσης σταματά και ο 
έλεγχος του προγράμματος στο Cx-Programmer. 

· Επιλέγοντας το Run the project γίνεται η αντίστροφη διαδικασία από ότι 
πριν. Άρα τώρα φαίνεται το τελικό αποτέλεσμα της εξομοίωσης. 
                                         
 

2.6 Σχεδιασμός προγράμματος στο Cx-Supervisor 
 
Για να υλοποιήσουμε ένα πρόγραμμα στο Cx-Supervisor πρέπει αρχικά να 
φτιάξουμε μία σελίδα αποθήκευσης. 

Οπότε κάνουμε τις εξής κινήσεις : 

File → New Project → Cx-Supervisor plus project 

Μετά επιλέγουμε που θα αποθηκεύσουμε το πρόγραμμα  

 

 

Εικόνα 11. 
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Παράδειγμα 

Έστω ότι ο έλεγχος ενός ηλεκτρικού φαναριού εξαρτάται αποκλειστικά από ένα 
μπουτόν.  

Λύση 

Αρχικά ξεκινάμε με τον σχεδιασμό του φαναριού. Επιλέγουμε τα κατάλληλα 
γραφικά αντικείμενα (Graphic Objects) και αλλάζουμε τα χρώματα μέσω του 
Forecolour .Τώρα επιλέγουμε ένα μπουτόν (Toggle Button) και το αποτέλεσμα είναι 
το ακόλουθο. 

 

 

Εικόνα 12. 

 

Στην συνέχεια πρέπει να φτιάξουμε μία μεταβλητή που θα μεσολαβεί για τον 
έλεγχο του φαναριού. Άρα πατάμε Point Editor→ Add Point → Point Name : GO και  
μετά OK.  
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Εικόνα 13. 

 
Το επόμενο βήμα είναι να δηλώσουμε αυτή την μεταβλητή στο μπουτόν. Οπότε 
πατάμε διπλό κλικ στο μπουτόν → Button Style : Toggle Switch μετά Browse → 
Point Name : GO → OK →OK 

 

 

Εικόνα 14. 
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Έπειτα επιλέγουμε με διπλό κλικ το κόκκινο λαμπάκι του φαναριού. Εμφανίζεται ο 
Animation Editor → Colour Change (Digital)  → Browse → Point Name : GO →OK → 
OK 

 

Εικόνα 15. 

 

Η ίδια ακριβώς διαδικασία ισχύει και για το πράσινο λαμπάκι. 

 

Εικόνα 16. 

 

Τώρα το πρόγραμμα είναι στο τελικό του στάδιο και μπορούμε να συνεχίσουμε 
στην εξομοίωση του. Άρα πατάμε Run the project για να δούμε αν λειτουργεί 
σωστά. 

Πρέπει να σημειωθεί ότι αυτό το παράδειγμα είναι η πιο απλή μορφή 
προγράμματος στο Cx-Supervisor. Δεν μπορεί να συνδεθεί ούτε με το Cx-
Programmer αλλά ούτε και με PLC. Βοηθάει μόνο στην εξοικείωση του χρήστη.      
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Κεφάλαιο 3ο - Δυνατότητες του PLC CP1L-M40 
3.1 Το PLC CP1L της εταιρίας OMRON 

 

Εικόνα 17. PLC OMRON 

 

Γενικές  Προδιαγραφές 

Το μοντέλο PLC που θα χρησιμοποιήσουμε είναι το  
CP1L-M40DT1-D και έχει τα εξής χαρακτηριστικά : 

Τροφοδοτικό  
24V DC 

Λειτουργικό  εύρος  τάσης    
20,4 με 26,4V DC 

Κατανάλωση  ενέργειας    
20W  μέγιστο 

Ρεύμα εισροής   

 
30A μέγιστο  σε χρόνο  20ms 
μέγιστο (για ψυχρή εκκίνηση σε 
θερμοκρασία δωματίου)  

Θερμοκρασία περιβάλλοντος 
λειτουργίας   

 
0 έως 55 °C  

Υγρασία περιβάλλοντος    
10% μέχρι 90%  

Ατμοσφαιρικό περιβάλλον 
λειτουργίας  

 
μη διαβρωτικό αέριο  

 
Πίνακας 1. Χαρακτηριστικά 
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3.2 Προδιαγραφές της μονάδας CPU 

 
Μέθοδος ελέγχου   
 

 
Προγραμματισμός  
 

 
Γλώσσα προγραμματισμού   

 
Ladder diagram  
 

 
Επαφές εισόδων (input bits)  
    

 
 24: CIO 0.00 μέχρι CIO 0.11   
 και CIO 1.00 μέχρι CIO 1.11            
 

 
Επαφές  εξόδων (output bits)   
 

 
16: CIO 100.00 μέχρι CIO         
100.07 και CIO 101.00 μέχρι   CIO 
101.07        
 

 
Βοηθητικές επαφές (work bits)   
 

 
W000.00 μέχρι W511.15  
 

 
Χρονικά (timers)   
 

 
4,096 bits: T0 μέχρι T4095 
 

 
Μετρητές (counters) 

 
4,096 bits: C0 μέχρι C4095 
 

 
Αριθμός μονάδων επέκτασης  
της CPU  

 
μέχρι  3 

 
Δυνατότητες επικοινωνίας  
 

 
Δυνατότητα σύνδεσης στο PLC 
μέχρι 2 καναλιών επικοινωνίας 
αλλά και με Ethernet 
 

 
High speed counter 

 
4 counters 

 
Πίνακας 2. Προδιαγραφές CPU 

 



 
 

3.3 Χαρακτηριστικά του PLC CP

 

Μπαταρία :  Παρέχει στο PLC 
φορτίζεται κάθε φορά που το PLC
περίπτωση. 

Περιφερειακή θύρα USB:  Επιτρέπει την σύνδεση σε μια περιφερειακή συσκευή 
όπως είναι ο προσωπικός υπολογιστής .

Αναλογικός έλεγχος :  Περιλαμβάνει 4 αναλογικές εισόδους και 2 αναλογικές 
εξόδους. Έτσι δίνεται η δυνατότητα στη μονάδα του 
ευρύ φάσμα εφαρμογών χωρίς να απαιτείται μονάδα επέκτασης.

Υποδοχή εξωτερικής αναλογικής εισόδου ρύθμισης 
χρησιμοποιείται ως αναλογική είσοδος με τάση που κυμαίνεται από 0 έως 10V. 
Μία συσκευή όπως ένα ποτενσιόμετρο
υποδοχή με δυνατότητα χειροκίνητης λειτουργίας. 

Διακόπτης DIP: Ένας διακόπτης 
διακοπτών που το περίβλημα του οποίου μοιάζει με τσιπάκι. Οι διακόπτες 
διακόπτες εναλλαγής ( toggle switches

 

CP1L-M40  

Εικόνα 18. 

 την υποστήριξη εφεδρικής μνήμης. Η μπαταρία 
PLC τροφοδοτείται  και αποφορτίζεται στην αντίθετη 

:  Επιτρέπει την σύνδεση σε μια περιφερειακή συσκευή 
όπως είναι ο προσωπικός υπολογιστής . 

:  Περιλαμβάνει 4 αναλογικές εισόδους και 2 αναλογικές 
εξόδους. Έτσι δίνεται η δυνατότητα στη μονάδα του PLC να μπορεί να χειριστεί ένα 
ευρύ φάσμα εφαρμογών χωρίς να απαιτείται μονάδα επέκτασης. 

Υποδοχή εξωτερικής αναλογικής εισόδου ρύθμισης : Αυτή η υποδοχή 
χρησιμοποιείται ως αναλογική είσοδος με τάση που κυμαίνεται από 0 έως 10V. 
Μία συσκευή όπως ένα ποτενσιόμετρο μπορεί να συνδεθεί στην συγκεκριμένη 
υποδοχή με δυνατότητα χειροκίνητης λειτουργίας.  

: Ένας διακόπτης DIP αποτελείται από ένα σύνολο ηλεκτρικών 
διακοπτών που το περίβλημα του οποίου μοιάζει με τσιπάκι. Οι διακόπτες 

switches ) δηλαδή έχουν δυο θέσεις ενεργοποίηση ή 
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την υποστήριξη εφεδρικής μνήμης. Η μπαταρία 
τροφοδοτείται  και αποφορτίζεται στην αντίθετη 

:  Επιτρέπει την σύνδεση σε μια περιφερειακή συσκευή 

:  Περιλαμβάνει 4 αναλογικές εισόδους και 2 αναλογικές 
να μπορεί να χειριστεί ένα 

τή η υποδοχή 
χρησιμοποιείται ως αναλογική είσοδος με τάση που κυμαίνεται από 0 έως 10V. 

μπορεί να συνδεθεί στην συγκεκριμένη 

πό ένα σύνολο ηλεκτρικών 
διακοπτών που το περίβλημα του οποίου μοιάζει με τσιπάκι. Οι διακόπτες DIP είναι 

) δηλαδή έχουν δυο θέσεις ενεργοποίηση ή 
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απενεργοποίηση. Χάρης τις οδηγίες εγκατάστασης του κατασκευαστή μπορούμε να 
ρυθμίσουμε αυτούς τους διακόπτες ανάλογα με την εφαρμογή που θέλουμε να 
υλοποιήσουμε.  

Θυρίδα μνήμης: Δεδομένα όπως τα προγράμματα καθώς και οι αρχικές τιμές της 
μνήμης μπορούν να αποθηκευτούν στην θυρίδα μνήμης και να αντιγραφούν σε 
άλλα συστήματα. Η θυρίδα μνήμης μπορεί επίσης να χρησιμοποιηθεί για την 
εγκατάσταση νέων εκδόσεων των προγραμμάτων εφαρμογής.   

Ακροδέκτες εισόδων και εξόδων: Οι ακροδέκτες εισόδων και εξόδων αποτελούν τις 
μονάδες επικοινωνίας της κεντρικής μονάδας με τον έξω κόσμο δηλαδή με τους 
αισθητήρες, τα μπουτόν, διακόπτες κ.α., που δίνουν τις εντολές στην κεντρική 
μονάδα (ακροδέκτες εισόδων), καθώς και τα ρελέ ισχύος των κινητήρων, 
ηλεκτρομαγνητικές βαλβίδες, ενδεικτικές λυχνίες που εκτελούν τις εντολές της 
κεντρικής μονάδας (ακροδέκτες εξόδων).   

Υποδοχή μονάδας επέκτασης: Συνδέοντας μια μονάδα επέκτασης με το PLC μας 
δίνεται η δυνατότητα να έχουμε περισσότερους ακροδέκτες εισόδων και εξόδων, 
άρα μπορούμε να υλοποιήσουμε πρόγραμμα μεγαλύτερης πολυπλοκότητας με 
περισσότερες δυνατότητες.  

Υποδοχή κάρτας επιλογής: Στην υποδοχή κάρτας υπάρχει η δυνατότητα 
επικοινωνίας του PLC μέσω Ethernet συνδέοντας μια κάρτα Ethernet στην υποδοχή. 
Επίσης μπορούμε να συνδέσουμε και άλλα μέσα επικοινωνίας όπως το RS-232C ή 
το RS-422A/485, τα οποία χρησιμεύουν για την επικοινωνία δύο ή περισσότερων 
PLC. Τέλος στην υποδοχή κάρτας επιλογής 1 μπορεί να συνδεθεί η οθόνη LCD 
CP1W-DAM01. Σε συνδυασμό με την κάρτα μνήμης CP1WME05M μπορεί να 
μεταφέρει ή να κατεβάζει κάποιο πρόγραμμα στο PLC χωρίς να χρειάζεται  φορητός 
υπολογιστής, αφού το πρόγραμμα ελέγχεται μέσω της οθόνης και αποθηκεύεται 
στην κάρτα μνήμης .Υπάρχει επίσης η δυνατότητα μεταφοράς ενός προγράμματος 
από ένα PLC σε ένα άλλο. 

  

 

 

                                              

 Εικόνα 19. RS-232C Εικόνα 20. RS-422A/485 
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Εικόνα 21. LCD CP1W-DAM01 Εικόνα 22. CP1W-ME05M 
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Κεφάλαιο 4ο - Έλεγχος και Οπτικοποίηση της 
Εφαρμογής του Ηλεκτρικού Τρυπανιού   
 

4.1 Περιγραφή και σχεδιασμός της εφαρμογής για τον έλεγχο του ηλεκτρικού 
τρυπανιού  

Σε αυτό το κεφάλαιο θα αναλύσουμε τον σκοπό της παρούσας πτυχιακής εργασίας, 
που είναι ο έλεγχος ενός ηλεκτρικού τρυπανιού σε δύο λειτουργίες την αυτόματη 
και την χειροκίνητη. Αρχικά θα γίνει η περιγραφή του αυτοματισμού και μετά η 
υλοποίηση του στο Cx-Programmer. Στην συνέχεια θα γίνει η οπτικοποίηση στο Cx-
Supervisor. Επίσης είναι αναγκαίο να λάβουμε υπόψιν ότι και τα δύο project των 
προγραμμάτων πρέπει να αποθηκευθούν στον ίδιο φάκελο για την σωστή 
εξομοίωση.   
 

4.2 Περιγραφή αυτοματισμού στο Cx-Programmer 

Όπως αναφέραμε προηγούμενος ο αυτοματισμός αποτελείτε από δύο λειτουργίες. 
Όταν επιλέξουμε την αυτόματη λειτουργία με το πάτημα του τερματικού διακόπτη 
για την κατεύθυνση προς τα δεξιά, το τρυπάνι κινείται δεξιά. Μόλις φτάσει δεξιά 
πατάμε έναν άλλο τερματικό για αριστερά, όταν περάσει ο χρόνος που έχουμε 
δηλώσει στο χρονικό το τρυπάνι κινείται αριστερά. Τώρα επιλέγουμε την 
χειροκίνητη λειτουργία. Με την επιλογή της κατεύθυνσης δεξιά το τρυπάνι κινείται 
δεξιά, με το πάτημα του τερματικού σταματά και ξεκινά πάλι αν πατήσουμε για 
άλλη μια φορά τον τερματικό. Το ίδιο ακριβώς ισχύει και για την άλλη κατεύθυνση. 
Επίσης έχουμε την δυνατότητα με το πάτημα ενός μπουτόν το τρυπάνι να κινείται 
προς τα κάτω και με κάποιο άλλο προς τα πάνω.   
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Είσοδοι  

Όνομα Διεύθυνση Σχολιασμός 

Auto I0.05 Επιλογή αυτόματης 
λειτουργίας 

auto start I0.00 Εκκίνηση αυτόματης 
λειτουργίας 

Finish I0.01 Απενεργοποίηση 
αυτοματισμού 

manual I0.06 Επιλογή χειροκίνητης 
λειτουργίας 

terminal right I0.02 Τερματικός κατεύθυνσης 
δεξιά  

terminal left I0.04 Τερματικός κατεύθυνσης 
αριστερά 

manual right I1.02 Χειροκίνητη επιλογή δεξιά 

manual left I1.03 Χειροκίνητη επιλογή 
αριστερά 

down  I0.09 Επιλογή κίνησης προς τα 
κάτω  

Up I1.04 Επιλογή κίνησης προς τα 
πάνω 

 
Πίνακας 3. 

Έξοδοι 

Όνομα Διεύθυνση Σχολιασμός 
output right Q100.0 Κατεύθυνση προς τα δεξιά 

output left Q100.01 Κατεύθυνση προς τα 
αριστερά 

out down Q100.02 Κατεύθυνση προς τα κάτω 

out up Q100.03 Κατεύθυνση προς τα 
πάνω 

 
Πίνακας 4. 

Επεξήγηση  

Αρχικά επιλέγουμε auto και μετά auto start για την αυτόματη λειτουργία. Με την 
βοήθεια της βοηθητικής επαφής W0.00 ενεργοποιείται ο τερματικός terminal right 
έτσι ώστε να ενεργοποιηθεί η βοηθητική W0.04 και μετά η έξοδος output right που 
κινεί το τρυπάνι δεξιά. 



 
 

Μόλις το τρυπάνι φτάσει δεξιά απενεργοποιείται η 
μέσω της βοηθητικής W0.02 (reset

 

Λόγω του ότι το reset 1 είναι ενεργό μένει ενεργός και ο τερματικός 
Αυτό έχει ως αποτέλεσμα να ενεργοποιηθεί το χρονικό μέσω της βοηθητικής 
W0.08. Όταν περάσει ο χρόνος ενεργοποιείται η επαφή του χρονικού η 
τερματικός terminal left είναι σε θέση 

 

 

 

Μόλις το τρυπάνι φτάσει δεξιά απενεργοποιείται η output right και αυτό γίνεται 
reset1)  

1 είναι ενεργό μένει ενεργός και ο τερματικός terminal
Αυτό έχει ως αποτέλεσμα να ενεργοποιηθεί το χρονικό μέσω της βοηθητικής 

0.08. Όταν περάσει ο χρόνος ενεργοποιείται η επαφή του χρονικού η 
είναι σε θέση on όπως και η βοηθητική W0.05. 
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και αυτό γίνεται 

 

terminal right. 
Αυτό έχει ως αποτέλεσμα να ενεργοποιηθεί το χρονικό μέσω της βοηθητικής 

0.08. Όταν περάσει ο χρόνος ενεργοποιείται η επαφή του χρονικού η T0. Έτσι ο 
 



 
 

Άρα μέσω της W0.05 το τρυπάνι κινείται αριστερά .

Όπως και πριν όταν το τρυπάνι φτάσει αριστερά ενεργοποιείται η βοηθητική 
(reset2) που απενεργοποιεί την output

 

 

 

0.05 το τρυπάνι κινείται αριστερά . 

Όπως και πριν όταν το τρυπάνι φτάσει αριστερά ενεργοποιείται η βοηθητική 
output left. 
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Όπως και πριν όταν το τρυπάνι φτάσει αριστερά ενεργοποιείται η βοηθητική W0.01 

 



 
 

Τώρα απενεργοποιούμε την αυτόματη λειτουργία και ενεργοποιούμε την 
χειροκίνητη (manual) 

Ενεργοποιείται η βοηθητική έξοδος 
της βοηθητικής W0.06 το τρυπάνι κινείται δεξιά (
τον τερματικό terminal right (όπως φαίνεται στην προηγούμενη σελίδα) το τρυπάνι 
σταματά. Ακριβώς η ίδια διαδικασία ισχύει και για αριστερά. Επίσης όπως και πριν 
ισχύει ακριβώς το ίδιο για τα reset
θέλουμε απενεργοποιείται η αντίστοιχη έξοδος.

Τέλος υπάρχουν άλλες δύο λειτουργίες του τρυπανιού κίνηση κάτω και
Μόλις ενεργοποιήσουμε την επαφή 
της εξόδου Q100.02 (out down

 

Τώρα απενεργοποιούμε την αυτόματη λειτουργία και ενεργοποιούμε την 

Ενεργοποιείται η βοηθητική έξοδος W0.03. Επιλέγουμε manual right και έτσι μέσω 
0.06 το τρυπάνι κινείται δεξιά (output right). Μόλις πατήσουμε 

(όπως φαίνεται στην προηγούμενη σελίδα) το τρυπάνι 
ίδια διαδικασία ισχύει και για αριστερά. Επίσης όπως και πριν 

reset.Όταν το τρυπάνι φτάσει στην κατεύθυνση που 
θέλουμε απενεργοποιείται η αντίστοιχη έξοδος. 

Τέλος υπάρχουν άλλες δύο λειτουργίες του τρυπανιού κίνηση κάτω και
Μόλις ενεργοποιήσουμε την επαφή down το τρυπάνι κινείται προς τα κάτω μέσω 

down). Ταυτόχρονα η βοηθητική W0.09 είναι ενεργή  
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Τώρα απενεργοποιούμε την αυτόματη λειτουργία και ενεργοποιούμε την 

 

και έτσι μέσω 
). Μόλις πατήσουμε 

(όπως φαίνεται στην προηγούμενη σελίδα) το τρυπάνι 
ίδια διαδικασία ισχύει και για αριστερά. Επίσης όπως και πριν 

.Όταν το τρυπάνι φτάσει στην κατεύθυνση που 

 

Τέλος υπάρχουν άλλες δύο λειτουργίες του τρυπανιού κίνηση κάτω και πάνω. 
το τρυπάνι κινείται προς τα κάτω μέσω 

0.09 είναι ενεργή  



 
 

όπως και το χρονικό. Μόλις περάσει ο χρόνος ενεργοποίησης του χρονικού με την 
βοήθεια της επαφής T1 το τρυπάνι σταματά.   

Ακολουθώντας τα ίδια βήματα όπως πριν ισχύει το ίδιο αποτέλεσμα αλλά για 
αντίθετη κατεύθυνση (επάνω).   

  

 

ς περάσει ο χρόνος ενεργοποίησης του χρονικού με την 
το τρυπάνι σταματά.    

 

Ακολουθώντας τα ίδια βήματα όπως πριν ισχύει το ίδιο αποτέλεσμα αλλά για 
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ς περάσει ο χρόνος ενεργοποίησης του χρονικού με την 

 

Ακολουθώντας τα ίδια βήματα όπως πριν ισχύει το ίδιο αποτέλεσμα αλλά για 
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4.3 Περιγραφή οπτικοποίησης στο Cx-Supervisor 

Το πρώτο πράγμα που κάνουμε είναι να καθορίσουμε την επικοινωνία του Cx-
Supervisor με το Cx-Programmer αλλά και με πιθανή σύνδεση με PLC. Αυτό το 
πετυχαίνουμε επιλέγοντας Device Setup→ Add PLC →Device Name : ptuxiakh (είναι 
το όνομα του προγράμματος στο Cx-Programmer) → Device Type→ CP1L (είναι ο 
τύπος του PLC που θα γίνει η σύνδεση) →Network Type : USB (τρόπος σύνδεσης με 
PLC). 

 

Εικόνα 23. 

 

 

Στην συνέχεια δηλώνουμε τις εισόδους και τις εξόδους από το πρόγραμμα 
αυτοματισμού που πραγματοποιήθηκε στο Cx-Programmer. Οπότε επιλέγουμε 
Point Editor→ Add Point→  Point Name : auto (όνομα εισόδου) →I/O Type : 
Input/Output (είδος μεταβλητής) → I/O Update Rate : On Interval 500 Milisec 
(χρόνος ενεργοποίησης) → Setup → PLC Name : ptuxiakh → Data Location : 0.5 ( 
θέση μνήμης που καταλαμβάνει η μεταβλητή auto) → OK → OK. Επίσης για το 
χρονικό υπάρχει μια διαφορά στο Point Type → Integer → Point Attributes 
(σημειώνουμε την ελάχιστη και την μέγιστη τιμή του χρονικού). 
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Εικόνα 24. 

 

 

Εικόνα 25. 

 

Με τον ίδιο τρόπο δηλώνονται και οι υπόλοιπες μεταβλητές εισόδου και εξόδου. 
Επιπλέον πρέπει να δηλωθούν άλλες δύο μεταβλητές, μια που θα καθορίζει την 
οριζόντια κίνηση του τρυπανιού και μια για την κατακόρυφη.  
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Για την οριζόντια φτιάχνουμε την mooove 

 

Εικόνα 26. 

Για την κατακόρυφη την verticaaal 

 

Εικόνα 27. 

Οι τιμές που έχουν επιλεχθεί στο Point Attributes καθορίζουν τα όρια της κίνησης 
που θα κάνει το τρυπάνι και έχουν επιλεχθεί κατόπιν δοκιμών. Στην συνέχεια 
φαίνονται όλες οι μεταβλητές που έχουν δηλωθεί στον Point Editor.  
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Εικόνα 28. 

Επόμενο βήμα είναι να σχεδιάσουμε τα μπουτόν για τις εισόδους και τους 
λαμπτήρες ένδειξης λειτουργίας για τις εξόδους. Ανοίγουμε το  Graphics Library 
Editor → NS Switches → Επιλέγουμε μπουτόν → Point Substitution (βγαίνει μόνο 
του) → Browse→  Select Required Item → Point Name: auto → OK 

 

Εικόνα 29. 

Πραγματοποιούμε την ίδια διαδικασία και για τις υπόλοιπες εισόδους και εξόδους. 
Εκτός από το χρονικό που με τον κέρσορα επιλέγουμε Text (επάνω αριστερά) και 
γράφουμε timer : # → διπλό κλικ επάνω του → Animation Editor→ Display Value( 
Analogue) → Browse → Point Names : timer →OK →Displayed Text:  timer:# → OK 



 
 

Εφαρμόζοντας την ίδια μεθοδολογία που περιγράψαμε καταλήγουμε στο 
ακόλουθο αποτέλεσμα.  

  

 

 

Εικόνα 30. 

Εφαρμόζοντας την ίδια μεθοδολογία που περιγράψαμε καταλήγουμε στο 

 

Εικόνα 31. 
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Εφαρμόζοντας την ίδια μεθοδολογία που περιγράψαμε καταλήγουμε στο 



 
 

  Το επόμενο στάδιο είναι η υλοποίηση της οπτικοποίηση

  
Αυτό που πρέπει να κάνουμε τώρα είναι να φτιάξουμε 
γίνεται για το λόγω ότι θέλουμε κάποια αντικείμενα που έχουν σχεδιαστή και 
αποτελούνται από πολλά κομμάτια να κινούνται  σαν ενιαία. Άρα με πατημένο το 
Shift επιλέγουμε με τον κέρσορα τα κομμάτια που θα μπουν στο 
δεξί κλικ → Group.   

Τα αντικείμενα που έγιναν group
τα κινούμενα μέρη της οπτικοποίησης. 

 

Στην συνέχεια είναι αναγκαίο να καθοριστούν τα όρια περιστροφής των τροχαλιών. 
Με τον κέρσορα στην περιοχή του 
κάθε τροχαλίας. Οπότε επιλέγουμε δεξί κλικ επάνω στο 
Rotate→ Browse→ mooove→ OK

 

όμενο στάδιο είναι η υλοποίηση της οπτικοποίησης του αυτοματισμού.

Εικόνα 32. 

Αυτό που πρέπει να κάνουμε τώρα είναι να φτιάξουμε group αντικειμένων. Αυτό 
γίνεται για το λόγω ότι θέλουμε κάποια αντικείμενα που έχουν σχεδιαστή και 
αποτελούνται από πολλά κομμάτια να κινούνται  σαν ενιαία. Άρα με πατημένο το 

επιλέγουμε με τον κέρσορα τα κομμάτια που θα μπουν στο group

group είναι το τρυπάνι και οι δυο τροχαλίες, που είναι 
τα κινούμενα μέρη της οπτικοποίησης.  

 

Εικόνα 33. 

Στην συνέχεια είναι αναγκαίο να καθοριστούν τα όρια περιστροφής των τροχαλιών. 
κέρσορα στην περιοχή του workspace αριστερά βρίσκουμε το 

κάθε τροχαλίας. Οπότε επιλέγουμε δεξί κλικ επάνω στο group→ Add
OK→ Επιλογή ελάχιστης και μέγιστης τιμής .
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του αυτοματισμού. 

 

αντικειμένων. Αυτό 
γίνεται για το λόγω ότι θέλουμε κάποια αντικείμενα που έχουν σχεδιαστή και 
αποτελούνται από πολλά κομμάτια να κινούνται  σαν ενιαία. Άρα με πατημένο το 

group και μετά 

είναι το τρυπάνι και οι δυο τροχαλίες, που είναι 

Στην συνέχεια είναι αναγκαίο να καθοριστούν τα όρια περιστροφής των τροχαλιών. 
αριστερά βρίσκουμε το group της 

Add Action→ 
Επιλογή ελάχιστης και μέγιστης τιμής . 
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Εικόνα 34. 

 

 

Εικόνα 35. 

 

Για την οριζόντια κίνηση του τρυπανιού κάνουμε το εξής όπως πριν Add Action→ 
Move (Horizontal)→ Browse→ mooove → επιλογή ορίων κίνησης → OK 
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Εικόνα 36. 

Τέλος ρυθμίζουμε την κατακόρυφη κίνηση του τρυπανιού 

 

Εικόνα 37. 

 

Η οπτικοποίηση έχει φτάσει σχεδόν στο τέλος της. Αυτό που μένει μόνο να κάνουμε 
είναι να φτιάξουμε ένα αρχείο Script. Σε αυτό το αρχείο θα πραγματοποιηθεί η 
γλώσσα προγραμματισμού VB Script που έχει λόγο ύπαρξης για την σωστή 
αλληλουχία κινήσεων των σημείων του αυτοματισμού. Χωρίς αυτήν δεν είναι 
δυνατή η υλοποίηση της οπτικοποίησης με κινούμενα μέρη.  

Για τον προγραμματισμό ενός αρχείου Script γίνονται τα ακόλουθα βήματα. Στην 
περιοχή του workspace αριστερά επιλέγουμε PTUXIAKH.PAG  δεξί κλικ → Add Page 
Script 



 
 

Εμφανίζεται ο Script Editor όπου θα γραφτεί ο κώδικας ανάλογα με τις λειτουργίες 
που θέλουμε να εφαρμοστούν.  

  

 

 

Εικόνα 38. 

όπου θα γραφτεί ο κώδικας ανάλογα με τις λειτουργίες 
 

Εικόνα 39. 
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όπου θα γραφτεί ο κώδικας ανάλογα με τις λειτουργίες 
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Η διαδικασία σχεδιασμού έχει ολοκληρωθεί άρα το μόνο που μένει τώρα είναι να 
γίνει η προσομοίωση των δύο προγραμμάτων αλλά και η σύνδεση τους με PLC.  

Ανοίγουμε το Cx-Programmer→ Work Online Simulator  και στο Cx-Supervisor → 
Project→ Run with Cx-Simulator (πρέπει να επιλεγεί το σωστό project του Cx-
Programmer) . 

 

Εικόνα 40. 

 

Στην συνέχεια για να γίνει η σύνδεση με το PLC κλείνουμε και τα δυο project 
εξομοίωσης. Συνδέουμε τον ηλεκτρονικό υπολογιστή και το PLC με ένα καλώδιο 
USB. Στο περιβάλλον του Cx-Programmer → Work Online→ Transfer from PLC (για 
να αφαιρέσουμε το παλιό πρόγραμμα από το PLC) →Transfer to PLC (για να 
μεταφερθεί ο καινούργιος αυτοματισμός). Στο περιβάλλον του Cx-Supervisor → Cx-
Supervisor Runtime.  

Η διαδικασία της εξομοίωσης ολοκληρώθηκε, οπότε τώρα είμαστε σε θέση να 
ελέγξουμε την ορθή λειτουργία της εφαρμογής που υλοποιήσαμε . 

  



 
 

Κεφάλαιο 5ο - Ηλεκτρολογική Μελέτη
5.1   Ηλεκτρολογική Μελέτη της Εφαρμογής του Ηλεκτρικού Τρυπανιού 

Σε αυτό το κεφάλαιο με τους κατάλληλους υπολογισμούς θα καθορίσουμε 
κινητήρια συστήματα καθώς και τα ασφαλιστικά μέσα που θα χρειαστούμε για την 
σωστή λειτουργία της εφαρμογής μας.

Καθορισμός φορτίων 

1) Κινητήρας  ηλεκτρικού τρυπανιού
2) Κινητήρας κατακόρυφης κίνησης
3) Κινητήρας οριζόντιας κίνησης 
4) Πίνακας φωτισμού 

Στον κάθε κινητήρα θα υπολογίσουμε την δ
θερμικό. Ενώ στον πίνακα φωτισμο
την ασφάλεια και την διατομή της παροχής .

Σχέδιο κατανομής φορτίων 

 

  

 

Ηλεκτρολογική Μελέτη 
Ηλεκτρολογική Μελέτη της Εφαρμογής του Ηλεκτρικού Τρυπανιού 

Σε αυτό το κεφάλαιο με τους κατάλληλους υπολογισμούς θα καθορίσουμε 
κινητήρια συστήματα καθώς και τα ασφαλιστικά μέσα που θα χρειαστούμε για την 

της εφαρμογής μας. 

ηλεκτρικού τρυπανιού 
Κινητήρας κατακόρυφης κίνησης 
Κινητήρας οριζόντιας κίνησης  

Στον κάθε κινητήρα θα υπολογίσουμε την διατομή καλωδίου, την ασφάλεια και το 
θερμικό. Ενώ στον πίνακα φωτισμού μόνο ασφάλειες. Στο τέλος θα υπολογίσουμε 
την ασφάλεια και την διατομή της παροχής . 

Εικόνα 41. 
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Ηλεκτρολογική Μελέτη της Εφαρμογής του Ηλεκτρικού Τρυπανιού  

Σε αυτό το κεφάλαιο με τους κατάλληλους υπολογισμούς θα καθορίσουμε τα 
κινητήρια συστήματα καθώς και τα ασφαλιστικά μέσα που θα χρειαστούμε για την 

ιατομή καλωδίου, την ασφάλεια και το 
ύ μόνο ασφάλειες. Στο τέλος θα υπολογίσουμε 
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Πίνακες που θα χρειαστούμε 

 

 

Πίνακας 5. Μέγιστη επιτρεπόμενη φόρτιση καλωδίων 

 

Πίνακας 6. Θερμοκρασιακός συντελεστής n1 
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Πίνακας 7. Συντελεστής γειτνίασης n2 

 

Τυπολόγιο 
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Υπολογισμοί 

1) Κινητήρας ηλεκτρικού τρυπανιού 

Pout =10 kW, cosφ = 0.83, n = 0.89 �τρυπ= �����/�.��√�∗���∗�.�� => ����� = 19.54 � 

Από πίνακα 6 => : 1.07 που είναι ο θερμοκρασιακός συντελεστής λόγο 
θερμοκρασίας περιβάλλοντος 25 ºC 

Από πίνακα 7 => : 0.73 που είναι ο συντελεστής γειτνίασης. Δηλαδή το σύνολο των 
καλωδίων που βρίσκονται σε επαφή. Τα καλώδια σε επαφή είναι 3 (οι κινητήρες) 
και στηρίζονται επάνω στον τοίχο. 

Άρα  Iτρυπ = (19.54*1.25)/1.07/0.73 = 31.27 A 

Επίσης ο συντελεστής 1.25 χρησιμοποιείται λόγο της εκκίνησης του κινητήρα σε 
αστέρα-τρίγωνο. 

Από πίνακα 5 επιλέγω διατομή  4×4 mm² όπου Io=34 A 

Άρα Imax = 34*1.07*0.73=26.55 A  

Επομένως     Iτρυπ ≤ ΑΣ1 ≤ Imax => 19.54 Α ≤ 25 Α ≤ 26.55 Α 

Η ασφάλεια θα είναι τύπου aM (βραδείας τήξης) και προστατεύει τον κινητήρα από 
βραχυκυκλώματα. Επιπλέον επιλέγουμε το ρελέ AC3 με IN ≥ 19.54 A 

Λόγω της εκκίνησης του κινητήρα με αστέρα-τρίγωνο θα πρέπει να υπολογιστή η 
ανάλογη διατομή καλωδίων καθώς και το θερμικό του κινητήρα ( προστασία από 
υπερφόρτιση ). 

IYΔ = 19.54/√3  =>   IYΔ = 11.28 A      

IYΔ = 11.28*1.25 = 14.1 A 

Από πίνακα 5 επιλέγω  4×1.5mm²  και το θερμικό το ρυθμίζω στα 11.28 A  
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2) Κινητήρας κατακόρυφης κίνησης  

Pout =2 kW, cosφ = 0.84, n = 0.86 ���� = ����/�.��√�∗���∗�.�� => ���� = 4 � 

Από πίνακα 6 => : 1.07  για  25 ºC 

Από πίνακα 7 => : 0.73  ο συντελεστής γειτνίασης 

Άρα  Iκατ = (4*1.25)/1.07/0.73 = 6.4 A 

Από πίνακα 5 επιλέγω διατομή  4×1.5 mm² όπου Io=18.5 A 

Άρα Imax = 18.5*1.07*0.73=14.45 A  

Επομένως  Iκατ ≤ ΑΣ2 ≤ Imax => 4 Α ≤ 10 Α ≤ 14.45 Α 

Η ασφάλεια θα είναι τύπου aM και το ρελέ AC3 με IN ≥ 4 A 

Λόγω της εκκίνησης του κινητήρα με αστέρα-τρίγωνο 

IYΔ = 4/√3  =>   IYΔ = 2.31 A 

IYΔ = 2.31*1.25 = 2.88 A 

Από πίνακα 5 επιλέγω  4×1.5mm²  και το θερμικό το ρυθμίζω στα 2.31 A 

 

3) Κινητήρας οριζόντιας κίνησης  

Pout =2.5 kW, cosφ = 0.85, n = 0.88 ��� = ����/�.��√�∗���∗�.�� => ��� = 4.82 � 

Από πίνακα 6 => : 1.07  για  25 ºC 

Από πίνακα 7 => : 0.73 ο συντελεστής γειτνίασης 

Άρα  Iορ = (4.82*1.25)/1.07/0.73 = 7.71 A 
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Από πίνακα 5 επιλέγω διατομή  4×1.5 mm² όπου Io=18.5 A 

Άρα Imax = 18.5*1.07*0.73=14.45 A  

Επομένως Iορ ≤ ΑΣ3 ≤ Imax => 4.82 Α ≤ 10 Α ≤ 14.45 Α 

Η ασφάλεια θα είναι τύπου aM και το ρελέ AC3 με IN ≥ 4.82 A 

Λόγω της εκκίνησης του κινητήρα με αστέρα-τρίγωνο 

IYΔ = 4.82/√3  =>   IYΔ = 2.78 A      

IYΔ = 2.31*1.25 = 3.48 A 

Από πίνακα 5 επιλέγω  4×1.5mm²  και το θερμικό το ρυθμίζω στα 2.78 A 

 

4) Πίνακας φωτισμού 

Τα φορτία που έχουμε είναι 5 φωτιστικά σημεία τον 100W  και 4 πρίζες σούκο. 
Επομένως για τις παραπάνω απαιτήσεις θα χρειαστούμε μια γραμμή φωτισμού 
τριών αγωγών (φάση, ουδέτερος ,γείωση) διατομής 1.5mm², η οποία θα 
ασφαλίζεται με μικροαυτόματο 10 � . Επίσης μία άλλη γραμμή τριών αγωγών 
τροφοδοτεί τις πρίζες σούκο διατομής 2.5mm² με μικροαυτόματο 16 � . 

Pφωτ = [500 + (230*16)] = 4.18 Kw ���� = �������  => ���� = 18.17 �  

Επειδή τα καλώδια της γραμμής φωτισμού βρίσκονται μέσα σε σωλήνα διαιρώ το 
ρεύμα με το 0.85 

Άρα ���� = ��.���.��  => ���� = 21.38 � 

Οπότε επιλέγω διατομή παροχής 4mm² και ασφάλεια τήξεως 20� gL για προστασία 
από υπερφόρτιση και βραχυκυκλώματα. Συνοψίζοντας για τον πίνακα φωτισμού 
τοποθετούμε γενικό διακόπτη μονοπολικό 25� (για τον έλεγχο της τροφοδοσίας), 
ΔΔΕ 25� με ευαισθησία 30mA (είναι το μέσο προστασίας από διαρροή ρεύματος) 
και τέλος την ασφάλεια τήξεως. 
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Συνολική Ισχύς  

IολR = 19.54*0.83+4*0.84+4.82*0.85+18.17*1= 41.84 A 

IολX = 19.54*sin*(cos¯¹0.83) + 4*sin*(cos¯¹0.84) + 4.82*sin*(cos¯¹0.85) = 34.65 A => 
IολX = 15.6 A ��� =  √IολR2 + Iολ�2 =  √41.842 + 15.62 => ��� = 44.9 � 

Διαιρώ  με το 0.85 επειδή η παροχή βρίσκεται σε σωλήνα  ��� = 52.8 �  

Από πίνακα 5 επιλέγω διατομή 4×10mm²  όπου Io=60 A 

Άρα Imax = 60*0.85=51 A  

Επομένως     Iολ ≤ ΑΣ ≤ Imax => 44.9 Α ≤ 50 Α ≤ 51 Α 

Όπου η ασφάλεια θα είναι τύπου g L 
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Επίλογος  

Στόχος της πτυχιακής εργασίας ήταν να αναδείξει τους προγραμματιζόμενους 
λογικούς ελεγκτές (PLC) και αυτό είναι προφανές εξαιτίας των πολλαπλών 
δυνατοτήτων που έχουν. Λόγω της εφαρμογής που υλοποιήσαμε καταλήξαμε στο 
συμπέρασμα ότι τα PLC είναι εύκολο να τα διαχειριστή ο προγραμματιστής, 
δίνοντας του επιπλέον την δυνατότητα μετεξέλιξης τους. Επίσης διαπιστώσαμε ότι 
χάρης του προγράμματος SCADA είναι εφικτός ο έλεγχος και η επιτήρηση 
βιομηχανικών εφαρμογών που μπορεί να βρίσκονται σε απόσταση. Τέλος για την 
ολοκλήρωση της πτυχιακής πραγματοποιήθηκε μια μελέτη, στην οποία 
καθορίστηκαν οι διατομές καλωδίων, τα μέσα προστασίας, καθώς και οι κινητήρες 
που θα χρησιμοποιηθούν για την υλοποίηση της εφαρμογής μας σε πραγματικές 
συνθήκες.     
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